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EarMaster 6 Teacher Edition – User Guide 

Introduction 
The Teacher Edition of EarMaster 6 has been designed to match the needs of 

music educators teaching ear training and sight-singing at all levels. Besides 

including all the features, activities and course material of the Pro version, the 

Teacher Edition also sports a Course editor, a database of melodies to 

incorporate into your exercises, user & class management tools, and advanced 

reporting tools to monitor the results of your students.  

The Course Editor will enable you to create your own sets of exercises, 

assignments and tests for any of the activities available in EarMaster 6. The 

courses created with the Teacher edition can be used by your students in the 

other editions of EarMaster 6, including of course the Pro version. 

The Melody database is a catalogue of the melodies available in EarMaster 6, which are used to generate 

questions in several activities such as sight-singing melodic dictation. The database comes with over 200 

melodies ready to be used in your courses, but add your own material with the melody editor or via MusicXML 

import. Alternatively, you can also set EarMaster to generate melodies automatically in your exercises.    

Student results overview opens a new window where you will be able to review the results of your 

students. Results can be filtered by class, date range, course, activity, and more.  

User administration and Class administration will help you organize your students in classes. It will then 

be very easy to assign a new course file to a whole class with one click, or to review the results of a single 

class at a time.  

General Procedure 
The 5 steps described below are the usual procedure to use EarMaster for educational purposes, from 

creating a set of exercises to receiving results from the students. These guidelines will be useful to most users, 

but EarMaster’s many options make it also possible to work differently.  

1. Create a course 

The first step is to create a course using the Course Editor. See the section on the Course Editor for more details 

on how to create courses in EarMaster.  

2. Distribute your course 

Once you have created your course, you will be able to distribute it to your students. Courses can be assigned 

to whole classes or specific students. Assigning a course can be done across a local network (EarMaster Lab 

Packs), via the Cloud (EarMaster Cloud Edition) or simply by email (All versions that include the Teacher 

features). For more details on how to assign a course across a local network or via the Cloud, please refer to 

the section on User Administration and Class administration.  

3. Your students train with your course  

Your students will train with the Course that has been assigned to them. Courses created with the Course 

Editor can be opened and used in other versions of EarMaster 6, including the Pro version.  

Home window – Teacher 

features 
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4. Receive your students’ results 

As your students complete the assignments you have given them, you will receive their results and be able to 

see detailed reports in the Student Results Overview window. If you are using EarMaster in a local network, the 

results will be saved on the server in real-time. If you are using the Cloud edition, the results will be synced 

automatically between your computer and the computers of the students via the school’s Cloud account. If 

you are using EarMaster completely offline, your students will need to use the export by email function of 

EarMaster to send you a file with their results.    

5. Review the results 

Once the results of your students have been loaded in your own copy of EarMaster via a local network, the 

Cloud or by email, you will be able to review them in the Student Results Overview window. The results can be 

filtered using various combinations of options: by date, class, course or activity.  

Course editor 

Overview 

The Course editor can be accessed from the Home window or from the Administration menu. It enables you to 

create and modify Course files made for EarMaster. These files can be used by your students in the other 

editions of EarMaster 6 instead of the built-in Courses (EarMaster Standard Course and EarMaster Jazz Course).  

Lesson grouping: mixed and separate activities 

EarMaster courses can be organized in 2 ways. You can either create a 

course where all the activities are independent from each other, or 

create a succession of lessons mixing different activities. The first scenario 

allows the user to work with the activity of his/her choice, whereas the 

second one is tailored to one single path defined by the course itself.  

Structure of a Course  

A Course is structured by 2 levels:  Modules and lessons. A module is simply a group of lessons, and the 

module title is the general heading of these lessons. In the example below, ‘Compare the Unison & Minor 2nd 

Intervals’ is a module, and the 3 items under it are the lessons included in that module:  

 

When you structure your courses, you can take advantage of the modules to organize your lessons according 

to a theme, a level of difficulty, curriculum steps and more.  

Lessons are the actual training material of your course. A lesson can be a simple exercise, an assignment or a 

test, depending on the settings you have selected.  

A common way to structure a course is to include in each module a group of lessons that introduce variations 

on the same theme. It could be for instance the same intervals, melody, or chords but executed differently, 

played in a different key or at a different tempo, etc. The passing threshold would be set very low (even as low 

as 0%), but the last lesson would be a test with a higher passing threshold. If the student doesn’t pass the last 

lesson, he would then have to retake the whole module.  

Creating a new Course 

To create a new Course from scratch, click on the New Course icon:  . 
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The Course property window will then be displayed. You will be able to define the general structure of the 

Course (mixed or separate activities), give the course a title, and write a general description of the content of 

the lessons.  

Adding modules 

To add a module, click on New Module and name the new module.  

Adding lessons 

To add a lesson, select a lesson that you would like to use as a template, and click on New lesson… Define the 

general parameters of your lessons with the options available in the Properties and New Lesson tabs of the 

lesson set up. By default, the new lesson will have the exact same properties as the “template” lesson, and will 

be inserted in the same module right after the original lesson. All the settings can be modified to make the new 

lesson a variation of the previous lesson, or a completely different lesson. For more details on how to 

configure a lesson, please refer to the section on Lesson Properties.  

Lesson properties 

Lesson properties let you configure a new or existing lesson. The lesson properties window is displayed each 

time you add a new lesson to a course, or if you double click an existing lesson.  

Lesson Title: Title of the lesson being edited. If nothing is specified, EarMaster will generate a title 

automatically according to the content of the lesson.  

Description of the lesson: In this field, you can describe the content of the lesson you are configuring. The 

lesson description is the perfect place to refer to specific chapters or pages in the students’ textbooks, to give 

tips on how to do the exercise, and to add small reminders on the theory behind the content of the lesson. 

Activities that include intervals or chords can generate automatic descriptions if the description field is left 

blank.  

Notice that the field for the description of your lessons allows html tags such as: 

 <b>Bold text</b> 

 <i>Italics</i> 

 <u>Underligned</u> 

 <link>www.earmaster.com</link>  

 <br>Line break</br> 

 <p>Paragraph</p> 

Using html tags will enable you to link to online material, to stress specific aspects of the lesson, or simply 

format your text for increased readability.  
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Questions: The number of mandatory questions asked by EarMaster for the lesson. 

Supplementary questions: Number of additional questions played by EarMaster if the student doesn’t 

reach the passing threshold after the default number of questions has been answered. This option gives you 

the possible to set a low number of mandatory questions to let advanced students move on faster, while the 

students having more difficulties with the exercises will be able to train more extensively.  

Adaptive questions: Adapt the content of the questions to the performance of the user. If a student has 

difficulties with some of the topics of the exercise (i.e. specific intervals, chords, scales, etc), the problematic 

content will be featured more often in the questions. For example, if a student fails to identify Major 3rd 

intervals in an exercise, EarMaster will automatically play that interval more frequently in the exercise.  

Allow visual/audio examples: If checked, this option will allow the student to obtain audio and visual 

examples of the items included in the lessons (intervals, chords, scales, etc.) before getting started with the 

assignment. When the Audio/Visual examples option has been activated, the students will see an ‘Examples’ 

button in the introduction of the lesson.  

Recommend next lesson: Minimum score that the student must reach to be advised to move on to the 

next lesson. If the percentage specified here is not reached by the students, they will be advised to retake the 

current lesson in order to obtain a better score.  

The “Recommend next lesson” setting is always allowing the students to move on to the next lesson if their 

score is above the passing threshold (see below). The main purpose of this option is to guide the students on 

what to do next by pre-selecting one of the available options: “Retake lesson” or “Move on to the next 

lesson”.  

 

Passing threshold: Minimum score that the student must reach to pass the lesson. If passed, the student will 

be allowed to move on to the next lesson. If failed, the student will be able to retake the lesson, but will be 

advised to take the lesson defined in ‘If failed, go to’ (see below).  

If failed, go to: Specify the lesson to load if the student fails the current lesson. 

High score points: Amount of points earned by the student for passing the lesson. The points are added to 

the high score board of EarMaster.   
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Add to module: Choose the module in which the lesson will be added. 

Copy activity setup: Select a lesson as a base template for your new lesson. This option makes it easy to 

add a succession of lesson with only few different parameters. The activity set up can be copied from an 

existing lesson, or from a Custom activity setup file.  

Saving your Course 

To save your Course, click on the Save icon:  or go FileSave Course or Save Course as… 

Courses can be saved on your local drive, in a shared location (Network version) or in the Cloud 

(Cloud edition). If the course is to be assigned to your students, it must be stored in a shared location on your 

local network or in the Cloud. The saving destination (local, shared folder or Cloud) is selectable at the 

bottom of the saving window, as shown below: 

 

Assigning your Course to students 

Assigning Courses is done on a user or a class basis. Refer to the section on User Administration and Class 

administration for more details on how to assign Courses to other users.  

Melody database 
EarMaster’s melody database is a collection of scores which can be used directly in your lessons for all the 

rhythmic and melodic activities: Melodic Dictation, Sight-Singing, Melody Imitation, Rhythmic Sight-Reading, 

Rhythm Imitation, Rhythm error detection, and Rhythmic Dictation.  

The melodies can be either monophonic (one melodic line), polyphonic (made of several voices), or be 

styled as lead sheets (melody accompanied by chords).  
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Using the Melody Database in a lesson 

Using a melody from the melody database in your Course is done in the very same way as when creating a 

customized exercise. Please refer to the section on Customizing the melodic activities for more details.  

Adding new melodies to the Melody Database 

New melodies can be added in two different ways. You can either notate them using EarMaster’s built-in 

melody editor, or import a melody from your favorite notation software via the MusicXML format.  

To add a new melody using the melody editor, click on the  icon. A detailed overview of the editor’s 

functionality is available in the Editing the Melody Database section. 

To open the MusicXML import window, click on the Import MusicXML button in the Melody Database window.  

Student Results Overview 
In the Student Results Overview window, you can easily see the results of a group of users and change their 

settings. 

All results and statistics apply only to the selected activity, unless the All activities icon is active ( ). In the 

Activities menu, you can choose for which activity you would like the results and statistics to be shown. 

Columns and panels of the Student Results Overview 

The columns and panels of the Student Results Overview window display information about the settings and 

results of each user. Most of these can be shown and hidden using the toolbar or the View menu. 

Name: The last and first name of the user 

Last result: Consists of three sub-columns with information about the last lesson completed: date, lesson title 

and result. 

Summations: The time period can be set from the View menu. The summations consist of three sub-columns:  
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Duration sum: The sum of the Duration column for the chosen time period. 

Average answer time: The sum of the Answer time column divided with the total number of questions. This is the 

average answer time (for one answer). 

Total result sum: The sum of the Total result column for the chosen time period.  

Course assigned: The Course that is loaded by default when the user opens EarMaster. 

Class: Name of the class the user is assigned to. 

Info panel: Panel with information about the user's current settings (properties) and the last completed 

lesson. 

Detailed results: Panel with detailed list of results for the selected user. It contains exactly the same 

information as the Results window. 

Toolbar 

The toolbar of the Student results overview lets you control what and how users and results are displayed.  

 

Filter by Activity 

Filter results by activity using the activity icons. The Star-shaped icon on the left side displays results for all 

activities.  

Filter by user type 

Choose the group of users to display in the list of users: All users, All students, All teachers, Users not in a class, or 

choose a specific class.  

Filter by date range 

Filter results by date. You can select one of the pre-defined date range from the drop-down list, or specify a 

custom date range by selecting a start and an end date.  

Filter by training mode 

Filter results by training mode. Training modes are courses (including your own courses) or custom exercises. 

Select one of the courses currently loaded in the system (including of course your own courses), or choose to 

only see results for customized activities.  

View menu options 

In the View menu, you can access most of the options available in the toolbar (see above), as well as a few 

additional ones: 

Show all attempts (ResultsShow all attempts): Shows the results of all the attempts to pass the lesson as 

separate entries. If this option is unchecked, EarMaster will only show the best result for each lesson. This 

option will show the number of attempts, which is the total number of times a lesson has been started and a 

result was saved.  

Detailed results: Displays a list of the results of the selected student. These detailed results are similar to those 

shown in the Statistics Window. Please refer to the section on Statistics for more details.  

User menu options 

In the User menu, you will find the following options to manage the users: 
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Assign Course file: Choose which Course file is loaded by default when the user opens EarMaster. 

Clear assignment: Clear a previously assigned Course for the selected user.  

Properties: See User Administration topic. 

Tip: To select multiple users, click on the first user you want to select. Press and hold the <Shift> key and click 

on the last user to select.  

User Administration 
The User Administration window is the place where you will be able to manage the EarMaster users of your 

school: 

Assign Course file: Choose which Course file is loaded by default when the user opens EarMaster. 

Clear assignment: Clear a previously assigned Course for the selected user.  

Properties: Change the properties for the selected user. You can set: name, user name, password, access 

rights, and default destination email address when exporting from EarMaster. If the user is an EarMaster Cloud 

user, most of these settings can only be changed in the Cloud administration website.  

Delete results: Delete all results prior to a specific date (applies only for the selected user). 

Delete user: Delete user from EarMaster, including all settings and results. EarMaster Cloud users can only 

be deleted in the Cloud administration website. 

Tip: To select multiple users, click on the first user you want to select. Press and hold the <Shift> key and click 

on the last user to select.  

Class Administration 
In EarMaster, a class is used to group several users together. This can be useful to assign Course files on a 

class basis, or filter users and results easily.  

The Class Administration window is available from the Administration menu of EarMaster, and in the bottom left 

corner of the Home Window. Notice that you must be logged in as Teacher or Administrator in EarMaster 

to see the Administration menu.  

Click on New class to create a new class. Then click Add/remove to add students to the class. To be added to 

a class, a student must already have a user profile in your local or Cloud account.  

Click Delete class to remove the selected Class. This will only remove the grouping of the users, so it will not 

delete the actual users or their results from EarMaster. 

System Administration Settings 
The system administration settings are available from the Tools menu. They are used to specify how users log 

in EarMaster so that their results, assigned courses and settings are loaded when the program starts. 

Local login 

A login interface specific to EarMaster will be displayed each time the program is started. In that login window, 

users will be able to login with their own credentials, or create new user profiles.  
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Use Windows/OS X Login 

The current Windows or OS X user account will be used to identify EarMaster users upon start up. EarMaster 

will keep separate records and settings for each Windows/OS X user on the computer. When using this 

authentication method, users do not need to type in credentials, as it is already handled by the operative 

system when the computer is started.  

Use Cloud account 

This option will display a window upon start up where EarMaster Cloud users will be able to login using their 

credentials. When users connect to their school’s cloud account, their results and assignments are instantly 

fetched and kept synchronized until the software is closed again.   


